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TOPSPIN

Bruker files are directory tree: required directory in bold, user input: between <>.
<dir>\data\<user>\nmr\<dataname>\<expno>\pdata\<procno>

<mydata>/<name>/<expno>/pdata/<procno>

Open File can be done with multitude of ways:
e Open data from menu (or tool bar), choose browser file.
e In Window explorer, go to your file and drag it in the graphic window

minimize maximize
title bar button button

menu

LI P Bruker TOPSPIN 2.0 on NMR-datastation as Jos van Bo... [= |[E1)[X]

upper
toolbar

ower [P EER & BB A AL T E N BE
toolbar 2. j2 *B /8 & *X = ﬁ.t/_ng@aa@ﬁ

Browser | PFoalio | Alias : B exam2d_HC 1 1 C:bio g... E\@EL data

File Edit View Spectrometer Processing Analysis Options Window Help bc 0se
utton

area
=4 C:\io - -1
| Gy quest Spectrum | ProcPars | AcquPars | Title | | [»
 F_Jexamld 13C T ek R
browser~f ' F-__]examid_1H S S SRR

- | exam2d_CH
I | =>cam2d HC
) exam2d_HH
[ ) exam3d
. @B
-] C:biot
F_ ) Cits13

[l W A S

/ .
commafnd line status bar 1D data window 2D data window

Expand Spectral Region

Drag with the left mouse around the region you want to expand. Or click on a on the lower tool
bar.

To Display integral or peaks on spectra:

Move mouse on data window, right click and choose Display Properties... in the popup menu.
Check the desired item.



To Display projection or 1D Spectra on a 2D:

If there are no projections, click on 4 in the upper tool bar. In the projection area, right click and
choose one of the option.

Extermal Projection ... : an existing 1D spectrum can be read.

Internal projection : a projection can be calculated and displayed.

To Superimpose spectrain multiple display mode

Click on = in the upper tool bar. When you open a new data set (or drag from browser), it will be
superimpose on current spectrum. You can scale and shift each spectra individually. Multiple display
is available for 1D as well as 2D data sets.

How to print the data:
To print the content of the data window: <Ctrl>p or use File = Print [select print active window]

You can also copy data to the clipboard and paste it in windows application.

How to process data

Use Topspin processing guide. In automatic mode it execute processing commands with default
parameters.

How to archive the data
File > Save - data set in Zip.

How to fit peaks and deconvolve overlapping peaks
Analysis = deconvolution

Data can be open in multiple window

Click in the browser on another data set : right click and select Display in a new window

In the Window menu you can select different arrangement like display in stack, display side-by-side
etc...

The mouse cursor in the data window is consistent with all data sets.

One of the window is active. (highlighted title bar) : it has mouse focus, menu and toolbar.



The Upper Tool Bar:

Da@ER e ®R 2d3d

Most useful buttons are : open file, print, Copy, Paste, Switch to last 2d dataset.

+ 1
A "I:-;':" AL T |.|J.|. ‘ ! : manipulation button.

Adjust Phase,

Calibrate,

Correct Baseline,

Enter Peak picking mode,
Enter integrate mode,

Switch to multiple display,
Distance measurement mode.

hp EL 4 | BB
Toggle Hz <> PPM
Y-Axis display : Abs, Rel, off
Overview : on/off
Grid toggle

The Lower Tool Bar:

12 2 *ﬂ B e F
/ / v = Intensity scaling
Double arrow: Mouse drag of intensity

Double arrow with limits: Reset Scale.

Intensity can also be changed with mouse wheel.
Intensity can also be changed with Keyboard : <Alt><PageUp>, <Alt><PageDown>,<Alt><Enter>

@ @‘E’l @ El @‘ ok E_l]'l : Horizontal scaling

Reset Full spectra window

Reset Full spectra window as well as the scale

Increase Zoom

Drag zoom with Left mouse

Decrease zoom

Enter Zoom with Dialogue box

Go to previous zoom

Retain Vertical and Horizontal zoom to display another data set

You can also zoom using left mouse drag in the data set.

- & 2|k -H:shiftspectra

Shift Left, with mouse Drag or Shift right. The last to move to the end of the window,



T t + : Vertical shift

Reset baseline in the center, Mouse drag the baseline, Reset baseline at the bottom.

File Handling

The Browser:

The Portfolio :

Eruw&er‘ PFolio ‘Aliaa

FHes C:h
= _l_'l C:thio
=~ _ 4 guest

e

+-__ | examid_1H
| exam2d_CH
| exam2d _HC
+_ | exam2d_HH
_] exama3d

 Browser | PFolio | Alias |

examld_13C 1 1 Chhio guest
examld_13C 2 1 Cbhio guest
examld_13C 3 1 Chio guest
examld_13C 4 1 Chhio guest
examld_13C 5 1 Cihio guest

4
4

displays last used datasets

If the browser is not visible : View = Browser panel On/Off

Working with Portfolio:
To save a portfolio: right click inside a portfolio and choose Open portfolio..., specify folder and

filename (with

.prop extension) and click save.

To open a portfolio: right click inside a portfolio and choose Save portfolio..., Navigate to the
folder and filename (with .prop extension) and click Open.

To remove data set from portfolio: right a dataset and choose Remove from portfolio..., click OK



MR Data Processzing Guide
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Open Data Set

G

Wiindowy Function
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Fourier Tranzform

EF

Phaze Correction
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B
=

Axis Calibration
+

A

Baszeline Corr.

(+ Butomatic mode

—

S

Advanced

+

1
Ja
Peak Picking
+

J

Integration

E-mail § Archive

Data processing

Semi-Automatic processing
Click Processing = Processing guide

Click on “Automatic mode”
Open a data set, click on “Window Function” -

“Fourier Transform” = “Phase Correction” etc... All
the steps will be executed without user interaction.

If “Automatic mode” is not selected, when you click on
a button, optional parameters are presented to you.

To Print/ Plot, click on printer icon in upper tool bar or
in processing guide, or type <Ctrl>p, or select File >
Print.

The print dialogue will appear.



Print Dialogue :

(9 print [Ctrl+P] - plot

Options

() Print active window [prrt]
(%) Print with layout - start Plot Editor [plot]
() Print with layout - plot directly [autoplot]

- Required parameters
LAYOUT = +1D_H.xwp v

Use plat limits Fill clata set list
(+) from screen /CY
() from Plot Editor Reset Actions
O as saved in Plot Edllor () from pottfolio saved in data set

() from your default portfolio

CURPLOT = Dell Photo AIO Printer 922

[ ox | [ concel |[ ter |

The “Print active window” will print the way data are displayed.

‘Print with Layout - start Plot Editor” — equivalent to typing ‘plot’

Print Integral and peak list:

Click in “integrals tab”, type “print” (or <Ctrl>p)
Click in “Peaks tab”, type “print” (or <Ctrl>p)

You can use also select data, copy the data and paste it in another application (like plot editor)

To Store data as Graphic File

Click on File = Export ..., navigate to the storage folder, enter file name and extension, Click on
“Export”



1D-Display
maximize
%atfa button
E title bar minimize close
Tab bar button button

examid_1H 1 1 C:hio guest

Spectrum | ProcPars | AdguPars | Title | PulseProg | Peaks | Integrals | Sample | Structure | Fid | Acqu|
1

o ] R
v
=
9_.3
10
_: il L | AR,
T ] T T T | T T T | T T T | T T T | T T T | T
10 8 6 4 2 [ppm]

You can display the same dataset in different window (convenient way to view various expansion or
various parameters (Spectra, peak picking...)

To reopen the same dataset, select : File > Reopen
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=101x]
Spectrum | PracPars | Acqupars| Tite| PuiseProg | Peaks| integrais | sampie| structure | Fia
i A i ‘ i“‘ J Al m R
TH Cvelosporin
T T | T T T | T T T_F | T T T | T T T | T
B.4 B.2 8.0 7.8 76 [ppm]
=10l x]
Spectrum' F'rDcF'arsl Acun‘arsl Titlel F'uISEF'ngl F'eaksl Integrals' Samplel Structurel Fidl
i .. S b | ‘“I I sl m )
TH Cyvelosporin
T T | T T T I T T T | T T T | T T T I T T T | T T T |
6.0 5.8 5.5 5.4 5.2 5.0 [ppm]

When you have multiple window, the manipulation button (scale width etc...) work only on the
active window.

To affect all the windows : use <Ctrl> + *2 (for example). Or <Ctrl> <Alt> <PageUp>

Display Peak list:
Click on Peaks tab:

.EHEIH’I'I[’_'IH 1 1 C:ibhio guest

| Spectrum | ProcPars | AcquPars | Title | PulseProg | Peaks | Integrals | Sample | Structure | Fid | Acqu

Eoponl | ety |
1 8.3923 1.70 i
2 83728 1.74
3 814939 192
: 4 8.1354 1.94
[ s s i
6 7.7360 204
Fi 7.58M1 z2m

By default peak list show Peak _ In current window

number, Chemical shift (ppm) and the
intensity. If you want more options 1 Delete
(like Hz listing), right mouse clickand - Remaove 4

select the option you want. L )
show detailed information...

Copy
To display the spectra around a peak,
right click on the peak and select . Export.
Import...
Print...

Tahle propeties. ..

In correlated window



11
“Expand spectrum in current window” This will change current display to spectrum display,
showing region around the peak.

Double clicking on a peak go to that displayed region.

Enter key, automatically display the zoom region containing the peak.

To export a peak list to an excel program, select the peaks (using Ctrl or Shift keys to select several
peaks), Right click and in the popup window select Copy. This table can then be pasted in Excel.

To delete or remove a peak from the list, Right click and in the popup window select Delete.
To remove duplicate peaks, choose Remove - Duplicate peaks

In the Table properties... , in the popup window, we can set columns to be viewed, and by
selecting one item, we can select number of decimal to be seen.

When the cursor move in a peak list and there is a correlated spectra displayed, the cursor vertical
line will move in the spectra showing the corresponding peak.

Display Integral list:
Click on Integrals tab.

examid_1H 1 1 CIBrukerTOPSPIN guest [1]

spectrum | procPars| AcquPars| Tite| Puiserrog | Peaks | integrals | sampie| structure| Fig |

i d .

ally .MI

i |

TH Cyvelosporin

.exam1d_1H 1 1 CBruker TOPSPIN

Spectruml F'rcncF'arsl Acun‘arsl Titlel F'ulseF'rUgl F'eaks' Integrals' Samplel Structurel Fidl

& Object Integral [abs] ks
E-Integral 1 TE427626.80 1.0000 2
Cintegrai2 7699436684 10074 2
---Integral 3 F2525312.62 0.94589 2
---Integral 4 T4320172.56 0.9724 2
""" Integral 5 g1077295.84 1.0608 o
---Integral & 74811814 .56 0.97589 2
""" Integral 7 1584841914 .53 2.0280 a
- Interral A RA22ANAR AR 1 NR3N 2
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Integral list displays integral number, The absolute value of the integral, The relative value of the
integral, the number of peaks in the integral region.

The selected integral is in black: if right clicking, enter or delete key is used, it will affect that
integral or set displayed window to that region. For popup menu, refer to description of peak list.

The active integral is in blue, the cursor in the data window indicate this integral.

To calibrate integrals to compare spectra

1. Right click the reference integral and choose: Define as reference in the popup menu.
2. Right click any integral and choose Calibrate by reference : this will divide all integrals by
calibration constant, setting reference integral to 1.0.

Now you can read amother spectrum and calibrate it’s integral with respect to the reference integral:

1. Read the spectrum and define integral ranges.
2. click on Integrals tab
3. Right click any integral and choose “Calibrate by reference”

jexam1d_1H 1 1 Cibio guest [1] =101 %
Spectrum | ProcPars | AcquPars | Title | PulsProg | Peaks | Integrals | sample | Structure | Fid |

Integral [aks] Peaks |Rang...|[Rang...| w(F1) [ppm] Intensity

#-integral 1 21807940.16  1.6664 4 7872 B.603 Al
S-integral 2 208B4637.28 15943 4 7410 7.870

| [-Peaks 7.7318 0.80

| |-Peaks 7.7062 0.84
|| [peak7 7524 o079
| LPeaks 7.5436 082
W-lntearal 3 4580932178  3.5003 1 7.056 7.408 =

exam1d_1H 1 1 Cibio guest [2] =l0lX]
Sﬁﬂﬂfuml F'rul:F'arsl ﬁ.cun’ar:al Title] FulsPngl Peakal Integralsl Eampiel Btrucmrel Fidl

[rel]

05

IIlI|IIIIII.IJlI|lI

85 8.0 75 7.0 [ppm]

If you click on the “+” sign to expand the integral, peak listing within this integral will be displayed.
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Display a structure:
Click on “Structure” tab, and click on Jmol button.

The viewer displays the structure file that resides in the expno of current dataset.

Following structure files are supported : .xyz, .mol, .pdb, .cml, .out, .mmlgp, .res, .cif, .gprm .hin,
.NWO

Rotate a molecule around x and y axis by left mouse dragging Left/Right, or up/down.

Rotate a molecule around Z by pressing middle mouse button and moving left/right.

Zoom in/out by pressing middle mouse button and moving up/down
. exam1d_1H 1 1 C:bio guest [1]

Spectrum | ProcPars | AcquPars | Title | PulseProg | Peaks | Integrals | Sample Structure | F (| »

File Edit Display VYiew Tools Macros Plugins Help

O @e=E QL ¢ 20 Editor

cyclosporing pdb - cyclosporing Oms: Bms

Spectrum Overview:

To toggle spectrum overview click on ~#_ in the tool bar.




examid_1H 1 1 C:'hio guest

Spectrum | ProcPars | AcquPars | Title | PulseProg | Peaks | Integrals | Sample | Structure | Fid | Acqu|

— -.---a.---.- . . L_lnLL:—IﬂJ—-L**
T
§
© 3
- Iy 2, MM
| I | 1 I | I | ] | ] I 1 [ 1 I | I | 1 I l I I I | I I 1 | 1 I |
86 8.4 8.2 g.0 7.8 7.6 7.4 [ppm]

The zoom region is shown in green. To shift the spectra, simply drag the green region on the
overview.



Display properties:

If you right click on a spectra and select Display
properties ..., You can select component you wish to
display.

To superimpose cursor information in the data
window, select that item.

You can decide to display the title, the parameters, the

integrals, the integral labels, Peak labels, Multiplets, etc...

Display Properies...

Save Display Region To...
Restore Display Region From Params. F1J2

File Properties...

Please select the componetts to be displayed
together with the spectrum (if available):

Cursor information
Title
Status parameters ]
Integrals
Irtegral lakbels
Peak labels []
Multiplets ]
Showy data points L]

| ok || cencel |
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2D Display

?.‘r““l title bar minimize  maximize close
1e.C button button  button
i

. exam2d_HC 1 1 C'hio guest

Spectrum ProcPars | AcquPars | Title | PulseProg | Peaks | Integrals | Sample | Structure | Fid | Acou
= ==
\ ﬁ = E_
e - £ - = &
Poul - &
. :__ o
E 00
o
- - | ﬁ
| 1 1 I 1 1 I I I I I | ! ! ! | ! | | | -
8 5 4 2 F2 [ppm]

To change intensity scaling:

*2 2 * M8+ *

Use scale buttons of lower tool bar : Rox |ﬁ - H like in 1D. Use the 5

button to change distance between levels.

Click on # to change # contours. Use the +/- button to toggle positive and negative contours. The

H button save the contour levels to disk

Use the mouse wheel to change the intensity when mouse cursor is in the graphics region.

You can also toggle square 2D layout ON/OFF with right mouse.

Zooming:

W E AR QA[oE e » ot 4[5 R
Reset Full spectra horizontal window

Reset Full spectra vertical window

Reset full spectra

Increase Zoom

Decrease zoom

Enter Zoom with Dialogue box
Go to previous zoom
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Retain Vertical and Horizontal zoom to display another data set

You can also zoom using left mouse drag in the data set.

The Left and right arrow: shift spectra in direction of the arrow.
You can use the “4-arrows” button to shift the spectra around by dragging.

The Up and Down arrow shift the spectra up and down.

A
The 3 last buttons apply to projection i| data: where you can rotate the oblique view in various
direction

.examEd_HH 3 1 C.Bruker'TOPSPIN guest =]

spectrum | ProcPars | AcquPars | Title| PulseProg| Peaks| ntegrais| sample | structure| Fig|

it w | MLEV Cyclosporin
wt - L.

b LT ]

If you Right-click inside 2D, popup menu can allow to display properties, Edit contour levels etc...

Display Properties...

Edit Contour Levels...

Save Display Reqgion To...
Restore Display Region From Params. F1)2

File Properties...
Square Layout OniOff

Files...

Various display options can be set in the Options = Preferences = spectrum

To display peak list:

Click on “Peaks” tab to display peaks.

Peaks can be calculated with the command “pp”

The list is similar to the 1D spectra. The difference is that there are 2 columns for the shifts in the 2
dimensions.
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Integral in 2D

Click on “Integrals” tab to display integration.

Peaks can be integrated with the command “int”

The list is similar to the 1D spectra. The difference is that there are 2 columns for the shifts in the 2
dimensions.

Spectrum overview

AL
You can switch spectrum overview with the button: —=*-_. The overview displays in green the zoom
region. You can move the region with the mouse.

#|

B exam2d_HH 3 1 C:BrukerTOPSPIN guest[2] =12 x|

Spectra projection can be obtained by clicking on :
I

SF'EEU’UI’H| F'ru:n:F'ars' ﬂu:un'ars' Title| F'ulseF'rn:ug' Peaks| Integrals' Sample' Si_“ll

il ¥ )A\.___J/\_/\_,____“/\_/\ﬂﬂvg

T e il

== 2 [ | MLEV Cyelosporin ;_E
o @@ L=~ =
= 5B @@D e 2 o
= o z M -t o
lﬁl a2 & = g 8|
Wwﬂ@ oh o - 3
-
C
[] =

2.5 2.0 15 F2 [ppm]

By Right clicking in projection area, One can select a 1D data set instead of projection. The little
sguare shown in the projection area serves to activate the 1D trace for vertical scale adjustment.
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I exam2d_HH 3 1 C:Bruker'TOPSPIN guest [2] =121x

SI:JEE’EFUFH| F'rn:u:F'ars' Acun‘ara' Title| F'uISEF'ngl Peaks| Integrala' Sample' Structure' Fid|

T R II S
-t R " - i @ : g
J‘ﬁEEﬁtﬁ:Gycmspﬂ n ) — . gt ‘_E
- C T
[ w
o
- 2]
-0
- 2]

25 2.0 15 F2 [ppm]

Display options

To display contour, use the button in the upper toolbar.
In the lower toolbar, the button 7 allow you to control the contour levels by opening the following
window.



[ exam2d_HC 1 1 C:\bio guest @

1 9990701 0 -9990701.0 A
2 17983261 9 17983261 9 |

3 32369871 4 -32363871 4 1
4 58265766 4 -56265760 4

5 104675363 2 1048783832

z 187810897 -186761069.7

7 339805961 5 -339805961 5

8 B11650730.7 -611650730.7

9 00 00

10 0.0 0.0 v

‘Required parameters
~Calculation method

(5) Muttiply with increment
() &dd incremert

Contour level sign

@ Positive & MNegative
{:} Positive
_ () Negative
Positive Megative
Base level 5669127 1 -5669127 A
Level increment  1.600 1.800
Murrber of levels 8

[ Fill ” Clear ” Apply ]

| Ok | | Cancel
You can calculate levels by selecting first:

“multiply with increment” : to create geometrical sequence of levels
“Add increment” : to create equidistant sequence of levels
e After selecting mode of calculation, enter the Base level, Level increment and number of
levels
e Click “Fill” to activate the sequence
e Click “Apply” to update the display (or OK to store levels, update the display and close
dialogue box.




The button : H found on the lower toolbar store the levels after interactive manipulation of the
intensity with scale buttons.

The button : = switch contour between, positive, negative or both.

21



22

Interactive manipulation (1D)

Interactive Window multiplication : Processing - Window Multiplication - enable Manual
window adjustment

exam1d_1H 1 1 C:hio guest B@@

M e | B B «
| winfunc T BT
Parameters gt~ L. |I I .
_ d 3 j '
lexpunerrtial WDV DWindoyy function type) -§ : .
| 03 % | Line broadening LB g3 ot
1 . s 1 E + ‘ i
I | Gaussgian max. position 0=GB=1 THTTTT T
| Sine bell shift SSE 8 6 4 [ppm]
()ssB= %
()35B=2 —
' Ty
01 deta 2
|
‘pﬁ ~ | PH_mod
1 2 3 4 [s]

The new window shows parameters on left, Spectra and FID on the left

The first buttons above the window - lll'lw "'Jl‘l can be used to select Spectra and FID together,
Spectra alone or FID alone.

The info button i switches cursor information on/off.

The saving buttons % g—' o can save parameters to 2D or 1D data set or simply return
without modification. (for 2D the 1D dataset was extracted using ‘rser’).

Interactive Phase correction:

In the upper toolbar, use the phase button : | A to enter in the phase mode.
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exam1d_1H 1 1 C:bio guest =10] x|

1 R[(90 -90180 | a2 = 0 &, H 4 I
pivot = 1.2508 ppn Phase increment = 0.20 phl = 0.00 phl = 0,00

s

0 5 10 [rel]

(RIS NNaREnnl FRR 1 NEN

15 10 5 0 [ppm]

The Yellow button indicates that you are in phase correction mode. Some button turn green when
they are clicked. As long as a button is green, it is active.

To perform phase correction:

1. Click-drag the 0 button and move the mouse until the reference peak in red is correctly
adjusted.

2. Click-drag the T button and move the mouse until the whole spectrum is well phased

3. Clickon EIJ to save phase correction and return.

By default the pivot point is set on biggest peak. To change the pivot point, Right-click on desired
pivot point, and choose “set pivot point” from popup menu.

To perform 90" or 180" phase correction use the correct button : a0 -90 180

To reset the phase to default value, use the R putton.

The saving and return buttons % q—' s can save phase to 2D or 1D data set or simply return
without modification. (for 2D the 1D dataset was extracted using ‘rser’).

1D integration

I

Click in integral button =  to enter in integrate mode.
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The yellow button in the active window toolbar indicates that the window is in the integral mode.
Any button that turn green indicate that it is activated.

To define an integral interactively:

1. click on define integral button = (it will turn green)

2. Put the red cursor at the beginning of the region you want to integrate and left drag to the
other end.

3. Define other regions in the same way. When finish deactivate the “define integral button”
(become gray)

To define integral exactly: click on '—'fl—' and enter the [‘! add E]
values for the integral region in the dialogue box Exact coordinates of integrated area
To select (or deselect) All displayed integral regions use : F1 [pprn]
= From

To select/deselect one integral, right click on it and choose R 4.477%

select / deselect from popup menu.

[ Ok H Cancel ]

-+ -
To select the next or the previous integral, use = = to
correct button.

To select several integration and not other, use the select all integral =, and by right click deselect a
few integrals.

Selected integrals are painted in green.
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To perform slope and bias correction, click-drag the button J'{E' -’E until integration is well
adjusted. The correction will occur on all selected integrals.

To calibrate and normalize integral:
Right-click in reference integral region and choose “Calibrate” in the popup menu. Type the desired
value.

To Normalize integrals
- This will set the sum of all integrals to a value, and adjust individual integral accordingly.

Right click on an integral and choose “Normalize” in the popup menu. Type the desired value.
Normalize and Calibrate only affect the current data set.
To scale integrals respect to Different spectra:
1. Right-click in the reference region
2. Choose “Lastcal” from the menu
This make sense only for spectra that have been acquired using same conditions.
The scaling factor is stored in /prog/curdir/<user>/intscale

To delete integrals from the display:

Select the integral in the display and click on o

To delete only one integral: right click in the integral and choose “Delete” from the menu

To scale selected or all integrals, use the scale buttons: 2 {2 % "R The *X putton scale the
integral by an amount that can be typed in.

The button =, scale all integral to the same height, showing scaling factor above the integral. Click
again on the button to go back to previous mode.
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To adjust the integral baseline (offset) select one of the following buttons : £+ T3

To cut an integral region, use the J'I'r button to activate (it will become green) this mode, move the
red cursor where you want to cut and click left mouse. When finish using deselect that mode.

Save Regions To ‘intrng’
To save integrals, use I—L a popup window will g J

appear: Save Regions To reg’

. .- , . Export Regions To Relaxation Module and .ret.
e Save regions to ‘intrng’ : save integrals

with slope and bias values. Save & Showv List
e Save Regions to ‘reg’ : save integrals to
the file ‘reg’

e Export Regions to relaxation module and ret : Use that on relaxation data only.
e Save and Show list : Save current integrals with slope and bias and show integrals on screen

Use H—' to save region to ‘intrng’ and return.

Use o if you want to return without saving.

1D-Calibration

. A : _—
Click on —=_ to enter in calibration mode.
Position the red cursor on the reference peak, Left-Click on the position, enter the value for that
peak.

Multiple display

The Button i | in the upper toolbar is used to create multiple display.
To add a data set you can:

e Left-drag the data from the browser

e Right-click and choose “Display” from popup menu

e Enter ‘re’ (read) and specify filename

Another way is to read multiple data sets simultaneously:
1. Inthe browser: hold <Ctrl> and select multiple data sets or hold <Shift> and select first and
last files of a series.
2. Right-Click any of the selected data files and choose “Display” Alternatively you can also
select “Display in a New Window”
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The Yellow button - | in the data toolbar indicates that the window is in -2 - jmod
multiple display mode. RS - cept 3

Some Buttons turn green ™ for as long as the button is active.

At the bottom of the browser, the datasets are displayed with the color they
have in the data window. The data sets that are selected appear highlighted
and in the data window, the data highlighted have full color square.

When no data set is selected: all data are selected.

To select / Deselect Datasets

Click on the spectra in the data window
Click on the small square in upper right of the spectrum window
Click on the small square in the lower left browser

The button s in the multiple display window deselect all data sets.

To remove a data set, select it and use the button e in toolbar.

14 - deptds
-5 - deptan
m-16-zgig30
- exam1d_1H
#-_ | exam2d_CH
- exam2d_HC

il ‘Imem HH T
3

examid_13C 1 1 CABruk

examid _13C 3 1 ChBruk
Examid_13C & 1 ChBruk

The button £ will show the difference between the first spectra and the sum of the other spectra.

=

The button = will show the sum of all spectra.

The button sl will save the sum/difference spectra: you have to specify the process number.

Al
The button il toggle between superimpose and stack display.

The button A toggle information on the spectra.

It is also possible to shift the baseline and scale of individual spectra in multiple display. To do this:

1. expand the region of interest



28
2. Select one spectra (you can also select a few spectra by clicking on them using the <shift>
or the <Ctrl> key)
a 2. /
To change the scale drag the up/down button ™5 or use the s % buttons.
To shift the baseline of the spectra, use ¥s .

To shift the spectra left or right, use i

o 0~ w

To reset scale/shift on selected spectra use : R

The last button of the toolbar : * go out of the multiple display mode.

To change the colors of the various datasets, click on Options = Preferences in the menu and
change colors.

1D interactive Baseline Correction
Baseline correction can be done automatically by using ‘abs’ or ‘absd’ commands.

For interactive baseline correction, use the L button on the upper toolbar.

=101 x|
A% Mk iz|A B C D E|0|an n|Ala|E 4 I

f{x) = A+ B7x + C°x% + Dx® + E"x¥ |

Mouse| Sensitivity: 1.0
10.3%9| ppm / 5194.75 Hz

11 dlahi b ol Lo UM
S

10 8 6 4 2 0 [ppm]

The yellow button “\ on the data toolbar indicate that baseline correction mode is active.
The buttons that turn green indicate that they are active.

To perform Polynomial Baseline Correction

1. Click on e

2. Drag button A until the red line coincide with the first data point.

3. Continue by dragging buttons B, C, D, E until the red line coincide with the entire baseline
on the spectra.

To perform Sine Baseline Correction

1. Click on o
2. Drag button A until the red line coincide with the first data point.
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3. Continue by dragging buttons B, C, D until the red line coincide with the entire baseline on
the spectra

To perform Exponential Baseline Correction

Click on &£

1.
2. Drag button A until the red line coincide with the first data point.
3. Continue by dragging buttons B, C, until the red line coincide with the entire baseline on the

spectra

To preview Baseline corrected spectra
1. Clickon & to preview corrected spectra which will be shown in red.

2. If baseline is correct, click on &l to save correction
3. If more correction is needed, deactivate the preview and correct more.

The button , reset correction line to zero.

To perform a Cubic Spline Baseline correction

LR
Click on the button £ to define points.
If a list of points exists you are prompted to overwrite or append to the list.

.exam1d_1H 1 1 CBruker'TOPSPIN guest =10l x|
e |« »]
[
El 79 ppm A 539827 HE E £ £ £ E =
: [- g - o o o £
i o) & o o o =
JDEFINE-LIAT OF POINTS ol |w o - w |
IDEfine: Leftzclick ([1nside data windem % E E 8 3 E
w w =+ = =] 4

Delets? Right-{clifk fen defiired pe
Save: Click-rightimouse button

10 8 -]

To define baseline points: move cursor to baseline point and left-click that position
Define at least 5 points

To save those points, use the button 5 of the Spline toolbar
To execute the Spline correction, use the Bl of the baseline toolbar.

> w e

To return without saving, use the < return button
To delete a data point, click on the data point with the right mouse and chose ‘Delete Current’ from

the Popup menu

Interactive Peak Picking
Peak picking is perform with the command “pps”
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+
To interactively list peaks, select the button - in the top toolbar.

.exam1d_1H 1 1 CIBruker'TOPSPIN guest ;lgli

9.95 ppm
Define ne
Drag with

4975.37 Hz
W region:
left mouse button

+
The yellow button - indicates that you are in peak picking mode.
Any buttons in green indicate that they are active.

The button = indicate that define range is active.

To define a peak range:

1. Drag the mouse from the upper left corner to the lower right corner

2. This will mark the range in green and will set the maximum / minimum intensity in which
pick picking occur. Peaks appear automatically.

3. Repeat step 1 and 2 for each range you wish to define

4. Click on the &= button to leave define range mode.

To modify existing ranges:

1. Click on “* to enter in the modify range mode

2. Put the cursor on the edge of a region and drag the green range to a new position. Peaks are
updated automatically to respond to the new region.

3. Click again on the modify range to leave that mode.

To delete all peak ranges use the ™ button.

+
To define a peak manually, activate the <L button and click on the peaks you want to list. When
finished, deselect the define peak button to leave that mode.

To delete a peak from peak list, Right-click on a define peak and select “Delete peak under cursor”
from the menu.

To delete all peaks, choose “Delete All Peaks” from the menu or click on # in the toolbar.
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To save the peak region and peak list, use the button q| on the toolbar. To discard the changes,
use the + button.

2D Interactive manipulations

2D Phase correction

To enter in phase correction in 2D, click on "'11«- in the upper toolbar.
lexam2d_HC 1 1 C:bio guest | =10 x|
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The yellow button "'l«- on top indicate that you are in phase mode.
The @j button toggle contour display on/off

The «Er button switch to row phase correction of selected peaks
The CI button switch to column phase correction of selected peaks

The QD button save phase values to the 3D data set from which 2D plane was extracted
The button + : return out of that mode.

Typical phase correction:

1. Select 2 or more peaks in different part of the spectrum
a. Zoom on a peak — draw a box around it with left mouse
b. Right-click at the peak and choose “Add” from popup menu
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c. Clickon & to go back to full spectrum and repeat step a. and b. to select another

peak

Bl exam2d_HC 1 1 Cobio guest
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2. Clickon € I to correct Column phase. A new window will show selected 1D column peaks
B Phase 2D : exam2d_HC 1 1 C:bio guest =|0]| x
A0 1 R|90 0180 a s 0+ =0 = % |H g K
pivot = 128.44 ppm Phase increment = 0.20 ph0 = 83.36 phl = -180.80
Column 417 {7.2569 ppm 0

\f

wﬂiﬁ‘m—}f’w“

—

Column 899 | .9748 ppm

3. Dragthe D button until red cursor peak (zero-order) is well phased

Drag the 1 button until other column are well phased
Click on Save Return to execute phase

The lll button arrange traces horizontally
The = button arrange traces vertically
The = button arrange traces in split window

Integration

To go in integration mode use the T button in the upper toolbar.

—
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The I yellow button indicate that you are in the integration mode.
Any button highlighted in green indicate that the function is active.

The == button define integral region (active when green)

The ** button Move integral region

The = Copy a region

The * Delete all regions.

The next 3 buttons I Read, Save and Define integral region.

The last 2 buttons : '« are used to Save and Return, or Return without saving.

To Integrate:
1. Define integral by defining a box around a region
2. in the popup menu, choose one of the options
a. Integrate:a: add up all intensities in the region
b. Integrate:+:add up all positive intensities in the region
c. Integrate:-:add up all Negative intensities in the region
d. Integrate:a+-:add up all intensities in the region and store separate entries for all
positive and negative intensities
e. Integrate:a+ :add up all intensities in the region and store separate entries for all
and positive intensities
f. Integrate:a-: add up all intensities in the region and store separate entries for all and
Negative intensities
g. Integrate:+-:add up all intensities in the region and store separate entries for
negative and positive intensities

3. Click on I button and choose “Integrate current regions” from pull down menu
4. Clickon I again and choose “List integral values” from pull down menu

Alternatively, you can define a reference integral and integrate defined regions of the same or
different dataset relative to this integral.

The I button offers following choices:
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e Integrate current regions rel. to reference (you will be prompted for reference integral
number and value)

e Listintegral values (list will show an additional column with normalized integral values

e Define current dataset as reference (you will be prompted for reference integral number
and value)

e Integrate and use ref. dataset for calibration (integral value on a reference dataset is used
for calibration)

To move integral, click on S and left-drag the region to desired position.
To copy an integral region click on 2 and left-drag the region to desired position

The save button will save regions to the filr “int2drng” in current PROCNO.

Multiple display in 2D

Any number of 2D and 1D spectra can be superimposed. Spectra are automatically aligned
according to the selected axis unit. A superimposed 1D is automatically displayed in the direction of
the matching nucleus.

Simply read a 2D dataset and click on multiple display button e in upper toolbar, then drag a 1D
or a 2D dataset in the window.

Data in multiple display mode can be individually shifted. To do that,
e Select the spectrs in the lower part of the browser

e Click-drag using the ‘iﬁ button.
o The button B reset scaling and shifting

Scan Rows / Columns

o LT ol
In multiple display mode you can scan for rows using button or for column using +*.
Once the button is activated, simply move the mouse in the spectra.

To increase the scale, turn the mouse wheel up or click with the Left mouse. To scale down, turn the
mouse wheel down or click on middle mouse button.

To grab a row/column (to keep it displayed), right-click once at the desired position and choose
“Grab Row/Column” from the menu. The row/column will appear in the browser.

To go to the next or previous row / column, use the + and — button.

To extract a row/column, right-click once at the desired position and choose “Extract
Row/Column” from the menu. A new window will appear where a new procno can be specified.
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For referencing
You can use the command ‘sref” for automatic referencing.

For manual referencing, Expand you reference peak on screen and use the "’;I"' button on the upper
toolbar. Enter the new reference value for both domains.

To measure distance between peaks

Use the R button in the upper toolbar to measure distance between peaks. Click on a peak and
drag the mouse to another peak. Distance is displayed as dragging occur.
To quit this mode simply Right-click the mouse.
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